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Output+

This document describes how to configure StreamServe Connect for SAP - 
Output+ with your SAP system. Output+ is an add-on module to StreamServer.

Note: This document only contains StreamServe information specific to the 
Output+ Connect solution. For general information about StreamServer, 
see the standard StreamServe documentation.

Output+ is one of four StreamServe Connect solutions available for use with SAP. 
For information on the other solutions, see the following guides:

• StreamServe Connect for SAP - E-docs

• StreamServe Connect for SAP - Business Processes

• StreamServe Connect for SAP - Delivery Manager

Installation

For information on how to install the StreamServe Connect solutions, see the 
StreamServe Connect for SAP - Installation Guide.

Introduction
The Output+ Connect solution enables you to receive SAPGOF data from your 
SAP system and process and distribute the data using StreamServer.

SAPGOF data
SAPGOF (SAP Generic Output Format) is an internal SAP format created using 
the SAPGOF printer driver. StreamServe supports the following SAPGOF data 
formats:

• SAPGOFU – written in UTF-16 format

• SAPGOF – written in ASCII format 

The header information lines of the data contain spool and print request 
information.

Using the Output+ Connect solution, StreamServe can receive the following types 
of SAPGOFU/SAPGOF data:

• Output Text format (OTF) — Output Text Format (OTF) data is created 
from Forms by the SAPscript Composer and Smart Forms in the SAP 
system.

• ABAP List data — ABAP List data is generated from Reports in ABAP/4 
language directly from the SAP system.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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SAPGOF data and StreamServe
SAPGOF data received as either OTF (Form) data or ABAP List (Report) data, 
maintains the original layout configured for the Form or the Report in the SAP 
system. You can use this original layout, or enhance the layout using the tools 
within StreamServe. 

You can personalize the output for each customer, and distribute the output to 
multiple destinations, including printers, fax machines and fax servers, archiving 
solutions, e-mail, PDF, HTML, and mobile devices.

Standard SAP output architecture
In a SAP system, you can print a document and thereby generate a spool request 
from various sources, including:

• an ABAP program (list output)

• a program editor

• the SAPscript word processing system. 

The SAP spool system manages all ‘printed’ documents as spool and output 
requests. The spool system holds the output generated by one of the document 
sources as a spool request. If the output is actually sent to a printer or fax machine, 
the spool system generates an output request and formats the data for output. 

Interface between SAP and StreamServe
The interface for business documents between SAP and StreamServe comprises 
a virtual printer. This means that to send SAPGOF data to StreamServe, you can 
simply print documents in the SAP system in the usual manner. 

Sending SAPGOF data from SAP to StreamServe

Output device

To process SAPGOF data generated from the SAP system using StreamServe, 
you use an output device of either SAPGOFU (Unicode) or SAPGOF (ASCII) 
type. 
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Transferring method

The way data is transferred from SAP to StreamServe depends on the host spool 
access method that you specify for the output device.

For more information on the host spool access methods, see http://help.sap.com

Host spool access 
method

Use for:

L • File copy using a common file share between the 
SAP spool server and the StreamServer host. This is 
recommended for high-volume printing.

• Local LPD/CUPS printing on UNIX.

U Remote LPD/CUPS printing on UNIX.

C Local spooler service printing on Windows.

S Remote Windows printing using the LPD server of the 
SAPSprint service.

F Local printing on front-end computer. Use for testing.

E The XOM interface. See the StreamServe Connect for 
SAP - Delivery Manager documentation.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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The following diagram illustrates how SAPGOF data is sent from the SAP system 
to StreamServe.

Note: StreamServe employs SAP tools and interfaces in all cases.

Figure 1 Sending SAPGOF data from SAP to StreamServe

1 OTF or ABAP List data is sent to SAPGOF printer driver

Within the SAP system, data is printed from SAPScript Forms or 
SmartForms (OTF data), or from an ABAP List report. The data is printed as 
a spool request using the SAPGOF output device.

2 SAPGOFU/SAPGOF printer driver writes the data to UTF-16/ASCII 

The SAPGOFU/SAPGOF printer driver generates a descriptive header from 
the internal SAP data (OTF or ABAP List), then converts the data into UTF-
16/ASCII format.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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3 SAPGOFU/SAPGOF printer driver sends the data to StreamServe

The SAPGOFU/SAPGOF printer driver writes the converted data to an 
external printer device, which in this case is the StreamServe port.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Example of setting up SAP connectivity
This example shows one way of setting up StreamServe as a virtual printer in 
Windows to use remotely with SAP. In the example, ABAB List data is to be 
printed through the SAPSprint LPD service. The following is required:

• Install Streamserve port monitor. 

See the StreamServe Installation documentation.

• Create a local spool folder. In this example, C:\strs_spool.

• Create and configure a local StreamServe printer.

• Install the SAPSprint service, see http://help.sap.com

• Check that the SAPSprint service is running on the StreamServe host 

(e.g. Control Panel > System and Security > Administrative tools > Services)

• Create and configure an output device in SAP.

Creating a local StreamServe printer

Add a new local printer by clicking Add a printer in the Devices and Printers 
dialog in Windows, and specify the following:

Note: In this example, Windows 7 is the OS.

Setting Value

What type of printer 
do you want to 
install?

Add a local printer

Choose a printer port Create a new port

Type of port StreamServe

Port name STRS

Destination: path/
named pipe/address

C:\strs_spool

Manufacturer Generic

Printers Generic / Text Only

Printer name STRS

Printer Sharing Share this printer so that others on your network can 
find and use it

Share name STRS

Set as default printer Uncheck this box, it should not be the default printer, and 
do not print a test page.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Creating an output device

1 Log on to the SAP client.

2 Enter /nspad in the transaction field. The Spool Administration: Initial 
Screen is displayed.

3 On the Output Devices row, click Display.

4 Click Change.

5 Click Create.

6 Enter a name for the Output Device

7 From the Device Type drop-down list, select SAPGOFU :Generic outp.fmt 
Unicode 1.0.

8 Select in the Spool Server field, and double-click the SAP server to use.

9 Select the Access Method tab.

10 From the Host Spool Access Method drop-down list, select the following:

S: Print Using SAP Protocol

11 In the Host printer field, enter the StreamServe port monitor printer you 
have created, STRS.

12 In the Destination host field, enter the host name or IP address of the 
StreamServe port monitor printer.

13 Save the device.

To test the device

1 Go back to /nspad and select to display output devices.

2 Click Print this list to output the list on your new device.

3 Select your output device and click Continue.

For better performance, select Do Not Query Host Spooler for 
Output Status.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Supported SAP releases
The Output+ Connect solution supports processing of Unicode SAPGOF data 
from NetWeaver 2004 and newer. 

Non-Unicode SAPGOF data is supported for release 4.6c and newer.

Not supported SAPGOF features
• RDE, e.g. PCL images

• “RT - Raw Text” command

• SmartForm Barcodes: Code 93 when printing to anything else but a label 
printer. 

• Restrictions on handling of OTF Raw Data commands (RD):

– Only bitmap data is supported

– All raw data types other than the following are not supported:

G The data contains a color bitmap graphic including a 
color table.

H The data contains a monochrome bitmap graphic.

I The data contains a monochrome bitmap graphic 
including a color table.

J The data contains a monochrome bitmap graphic.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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The StreamServe configuration
StreamServe Design Center is used to configure StreamServe Projects, which 
determine how StreamServer handles both OTF (Form) data and ABAP List 
(Report) data. 

Configuration in previous StreamServe releases

Using Design Center, you can upgrade and maintain Messages created using the 
PageIN and FormOUT tools.

Platform No specific configuration settings are required for the 
input connectors and output connectors in the platform 
for SAPGOF data. 

Message You configure a Message for OTF (Form) data or ABAP 
List (Report) data using the PreformatIN Event, and any 
type of Process, such as StoryTeller or XMLOUT. You 
must create a separate PreformatIN Event for each form 
or report you want to extract data from.

Resources The SAPGOFLXF filter is defined in a Filter Chain, and 
added as a Resource to the Resource Set. This Filter 
Chain can be attached to an input connector in the 
Platform configuration. 

Runtime For StreamServer to recognize and handle SAPGOF data, 
a SAPGOFIN filter is used at runtime to convert 
SAPGOF data into LXF (Layout eXchange Format).
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF 
data

To configure SAP system to send OTF or ABAP List data for processing in 
StreamServe, you need to create an output device in your SAP system of 
SAPGOF type. 

You can use SAPGOF device either to generate sample SAPGOF data, or send 
SAPGOF data to StreamServer for processing.

See Sending SAPGOF data to StreamServe on page 18.

Creating a Unicode (UTF-16) SAPGOF output device 
To configure SAP to send OTF or ABAP List data in Unicode format to 
StreamServe, you must create an output device in your SAP system of SAPGOFU 
type. 

To create an SAPGOF output device

1 Log on to your SAP system as a user with administrative permissions.

2 Enter /nspad in the transaction field. The Spool Administration: Initial 
Screen is displayed.

3 On the Output Devices row, click Display.

4 Click Change.

5 Click Create.

6 Enter a name for the Output Device.

The SAPGOF documentation is available for SAP customers and 
consulting partners on SAP Net (https://websmp103.sap-ag.de/output 
- search for “Generic Output Format” to locate the PDF file on 
SAPGOF).
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF data
7 Click the DeviceAttributes tab, and specify the device settings.:

8 Click the Access Method tab.

9 Specify the host spool settings.:

10 Click Enter. 

11 Save the device definition.

Creating an ASCII SAPGOF output device 
To configure SAP to send OTF or ABAP List data in ASCII format to 
StreamServe, you must create an output device in your SAP system of SAPGOF 
type.

To create an SAPGOF output device

1 Log on to your SAP system as a user with administrative permissions.

2 Enter /nspad in the transaction field. The Spool Administration: Initial 
Screen is displayed.

3 On the Output Devices row, click Display.

Device settings

Device type Select SAPGOFU: Generic outp. fmt Unicode 1.0.

Device class Select Standard printer.

Host spool settings

Host Spool 
Access Method

See Transferring method on page 7

To print sample files (for test purposes), you must use 
the F (Front-end) method. For an 

Note: If you select an access method that requires a 
spool server, you must specify the server on 
the DeviceAttributes tab.

Host printer The name of the StreamServe printer queue, for 
example strs. For information on configuring the 
printer queue, see

• Creating a local printer definition on page 18.

• Example of setting up SAP connectivity on page 
10.

Note: The name of the host printer is case sensitive 
and cannot contain any spaces.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF data
4 Click Change.

5 Click Create.

6 Enter a name for the Output Device.

7 Click the DeviceAttributes tab, and specify the device settings.:

8 Click the Access Method tab.

9 Specify the host spool settings.:

10 Click Enter. 

11 Save the device definition.

Device settings

Device type Select SAPGOF: Generic output format ASCII.

Device class Select Standard printer.

Host spool settings

Host Spool 
Access Method

See Transferring method on page 7

To print sample files (for test purposes), you must use 
the F (Front-end) method.

Note: If you select an access method that requires a 
spool server, you must specify the server on 
the DeviceAttributes tab.

Host printer The name of the StreamServe printer queue, for 
example strs. For information on configuring the 
printer queue, see

• Creating a local printer definition on page 18.

• Example of setting up SAP connectivity on page 
10.

Note: The name of the host printer is case sensitive 
and cannot contain any spaces.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF data
Sending SAPGOF data to StreamServe
To output data from your SAP system to StreamServe using the SAPGOF driver, 
you need to complete the configuration describe in this section. To assist you, this 
section contains two examples of how to send OTF data (Form data) and ABAP 
List data (Report data) to StreamServe using the SAPGOF driver. You should 
ensure that these scenarios work correctly before starting to create the actual Form 
or Report. These examples are configured for a Windows environment.

If you only want to generate a SAPGOF file, without sending it to StreamServe 
(in case StreamServe is not installed), see Creating a SAPGOF output file on page 
21.

Included activities

To send SAPGOF data to StreamServe, complete the following steps:

1 Create a SAPGOF output device for sending SAPGOF data to StreamServe:

See Creating an ASCII SAPGOF output device on page 16.

2 See Creating a local printer definition on page 18.

3 Send sample data to StreamServe:

– See Sending sample Form data to StreamServe on page 19

– See Sending sample ABAP List data to StreamServe on page 20

Creating a local printer definition
To capture data on your SAP system, you need to create a printer definition on 
your local machine (Windows) that you can use to receive data as the 
StreamServe port.

To create a printer definition

1 On your local machine, add a printer definition with the following settings:

Printer definition settings

Local or Network 
Printer

Select Local printer.

Note: Ensure Automatically detect and install my 
Plug and Play printer is not selected.

Port A new port of StreamServe type. 

Note: The StreamServe port type is only available 
when you have installed StreamServe Port 
Monitor.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF data
2 Right-click the new printer and select Properties > Advanced > Print 
Processor.

3 Select passthru and RAW.

Sending sample Form data to StreamServe
You print sample Form data (OTF) from your SAP system using the SAPGOF 
output device configured to use the local printer definition.

Note: This section uses an invoice from the SAP system as an example.

To send sample Form data to StreamServe

1 Log on to your SAP system as a user with administrative permissions.

2 In the transaction box, enter /nvf03. The Display Billing Document 
window opens.

3 In the Billing document box, select the billing document you want to print.

4 Select Billing document > Issue output to > Printer. The Issue Output 
dialog box opens.

5 Ensure the correct output type is used. (The standard output type for an 
invoice is usually RD00.) Click Execute.

6 In the Logical destination box, enter the name of the output device you 
created for sending SAPGOF data to StreamServe.

Port Definition A name for the port, such as strs. 

Note: The port name must match the name of the 
host printer name specified for the SAPGOF 
output device. 

Enter a destination path/pipe to the StreamServe spool 
from where StreamServer will receive data, for 
example:

C:\StreamServe\spool

Manufacturer Generic

Model Generic/Text only

Printer Name A name for the printer, For example, strs.

Note: Do not specify the printer as the default printer.

Shared As A share name for the printer, for example strs. 

Note: The share name must match the name of the 
host printer name specified for the SAPGOF 
output device.

Printer definition settings
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF data
See Creating an ASCII SAPGOF output device on page 16.

7 Ensure Print immediately is selected.

8 Click Execute. If printing is successful, your SAP system will launch 
SAPLPD on your local machine showing the print job in the log file. See 
Supported SAP releases on page 12. The output is sent to the device.

The output file is sent to the directory specified for the port definition of the 
local printer definition, for example C:\StreamServe\spool, see Creating a 
local printer definition on page 18.

Sending sample ABAP List data to StreamServe
To send ABAP List data from your SAP system, you print reports in the usual 
manner using the SAPGOF output device. The SAPGOF device type sends the 
output data as an ASCII file to the host printer defined for the output queue - the 
StreamServe printer queue.

Note: This section uses a material document list from the SAP system as an 
example.

To send sample ABAP List data to StreamServe

1 Log on to your SAP system as a user with administrative permissions.

2 In the transaction box, enter /nmb51. The Material Document List window 
opens. 

3 Click Execute. All available materials are listed.

4 Double-click the material you want to view and print as a report. The details 
of the material are displayed.

5 Select List > Print. The Print Screen List window opens.

6 In the Output device box, select the name of the output device you created 
for sending SAPGOF data to StreamServe.

See Creating an ASCII SAPGOF output device on page 16.

7 Ensure Print immediately is selected.

8 Click Execute. If printing is successful, your SAP system will launch 
SAPLPD on your local machine showing the print job in the log file. See 
Supported SAP releases on page 12. 

The ABAP List data is output as an ASCII file to the host printer defined for 
the SAPGOF output device - the StreamServe printer queue.

Output file extension (*.gof) 

Ensure that the extension of the output file is .gof. If the output file 
has another extension, you will not be able to import the file into the 
PreformatIN tool, and the file will not automatically be converted to 
LXF format.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A
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Configuring SAP to send SAPGOF data
Creating a SAPGOF output file
To create a SAPGOF output file, you need to complete the following steps:

1 Create a SAPGOF output device for sending sample SAPGOF data to 
StreamServe.

See Creating an ASCII SAPGOF output device on page 16.

Note: When configuring a SAPGOF output device for sending sample 
SAPGOF data, ensure you specify the access method as F to print 
locally to a front end printer.

2 Creating a printer definition for sample SAPGOF data on page 21

3 Print sample data to StreamServe:

– Printing sample Form data to StreamServe on page 22

– Printing sample ABAP List data to a file on page 23

Creating a printer definition for sample SAPGOF data
To create a SAPGOF output file, you need to create a printer definition on your 
local machine (Windows) that you can use to send the sample data as a file to your 
local machine.

To create a printer definition for sample SAPGOF data

1 On your local machine, add a printer definition with the following settings:

Printer definition settings

Local or Network 
Printer

Local printer

Note: Ensure Automatically detect and install my 
Plug and Play printer is not selected.

Port A new port of StreamServe type. 

Note: The StreamServe port type is only available 
when you have installed StreamServe Port 
Monitor.

Manufacturer Generic

Model Generic/Text only

Printer Name A name for the printer, For example, strs.

Note: Do not specify the printer as the default printer.

Shared As A share name for the printer, for example strs. 

Note: The share name must match the name of the 
host printer name specified for the SAPGOF 
output device.
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Configuring SAP to send SAPGOF data
2 Select Printer > Properties > Advanced > Print Processor with a 
Passthru print processor with a RAW default.

Printing sample Form data to StreamServe
You print sample Form data (OTF) from your SAP system using the SAPGOF 
output device you configured to use the local printer definition. The sample data 
is sent from your SAP system to your local machine as a file.

Note: This section uses an invoice from the SAP system as an example.

To print sample Form data to a file

1 Log on to your SAP system as a user with administrative permissions.

2 In the transaction box, enter /nvf03. The Display Billing Document 
window opens. 

3 In the Billing document box, select the billing document you want to print.

4 Select Billing document > Issue output to > Printer. The Issue Output 
dialog box opens. 

5 Ensure the correct output type is used. (The standard output type for an 
invoice is usually RD00.) Click Execute. The second Issue Output dialog 
box opens. 

6 In the Logical destination box, enter the name of the output device you 
created for sending sample SAPGOF data to StreamServe. See Creating a 
printer definition for sample SAPGOF data on page 21.

7 Ensure Print immediately is selected.

8 Click Execute. If printing is successful, your SAP system will launch 
SAPLPD on your local machine showing the print job in the log file. See 
Supported SAP releases on page 12. The output is sent to the printer and the 
Print to File dialog box opens.

9 Enter the full path and name of the SAP output file, for example:

C:\StreamServe\invoice.gof

10 Click OK. You can import this file into the Event tool to build the Form 
Message.

Output file extension (*.gof) 

Ensure that the extension of the output file is .gof. If the output file 
has another extension, you will not be able to import the file into the 
PreformatIN tool, and the file will not automatically be converted to 
LXF format.
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Configuring SAP to send SAPGOF data
Printing sample ABAP List data to a file
You print sample ABAP List data from your SAP system using the SAPGOF 
output device you configured to use the local printer definition. The sample data 
is sent from your SAP system to your local machine as a file.

Note: This section uses a material document list from the SAP system as an 
example.

To print sample ABAP List data to a file

1 Log on to your SAP system as a user with administrative permissions.

2 In the transaction box, enter /nmb51. The Material Document List window 
opens. 

3 Click Execute. All available materials are listed.

4 Double-click the material you want to view and print as a report. The details 
of the material are displayed.

5 Select List > Print. The Print Screen List window opens.

6 In the Output device box, enter the name of the output device you created 
for sending sample SAPGOF data to StreamServe. See Creating a printer 
definition for sample SAPGOF data on page 21.

7 Ensure Print immediately is selected.

8 Click Execute. If printing is successful, your SAP system will launch 
SAPLPD on your local machine showing the print job in the log file. See 
Supported SAP releases on page 12. The output is sent to the printer and the 
Print to File dialog box opens.

9 Enter the full path and name of the SAP output file, for example:

C:\StreamServe\material.gof

10 Click OK.

Output file extension (*.gof) 

Ensure that the extension of the output file is .gof. If the output file 
has another extension, you will not be able to import the file into the 
PreformatIN tool, and the file will not automatically be converted to 
LXF format.
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Configuring SAP to send SAPGOF data
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Creating Messages for SAPGOF 
data

This chapter describes how to create StreamServe Messages for SAPGOF data — 
OTF (Form) data and ABAP List (Report) data — using the StreamServe Design 
Center and the PreformatIN tool. You can use Process tools such as PageOUT or 
XMLOUT, to create the final output.

Note: The StoryTeller Process tool can not be used.

Included activities

• Creating Messages for SAPGOF data on page 26

• Defining a PreformatIN Event for SAPGOF data on page 27

• Defining a Process for SAPGOF data on page 29
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Creating Messages for SAPGOF data
Using Design Center to create a Message for OTF (Form) data or ABAP List 
(Report), you configure the Message using a PreformatIN Event, and any type of 
Process, such as PageOUT or XMLOUT.

To create a Message for SAPGOF data

1 In Design Center, create a new Message definition.

2 Add a PreformatIN Event to the Message.

Multiple-page forms or reports

If the report or form consists of multiple pages with different page 
layouts, you will need to configure Messages that will handle both 
pages. For example, you can create two Messages with different 
Patterns to process a two-page report with different page layouts.
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Defining a PreformatIN Event for SAPGOF 
data

For each Form or Report you want to extract data from, you must create a separate 
PreformatIN Event. 

You create an Event for SAPGOF data based on the original SAPGOF file. When 
you import the SAPGOF file in the PreformatIN tool, the data is automatically 
converted into LXF (Layout eXchange Format) format.

To configure a PreformatIN Event for a Form or a Report, you can use dynamic 
overlays, or you can identify and extract the data by mapping blocks and fields.

Included activities

• Importing a sample SAPGOF file on page 27

• Identifying and extracting SAPGOF data on page 28

• Saving SAPGOF data as a dynamic overlay on page 28

Importing a sample SAPGOF file
To configure the layout of SAPGOF data in a PreformatIN Event, you load a file 
(grab file) containing sample data from your SAP system. A grab file contains a 
copy of data that you can use to map the layout of Form data from your SAP 
system to StreamServe.

To load a sample SAPGOF file into PreformatIN

1 Add the sample file to the resource set by right-clicking the samples folder 
in the resource set and select Import.

2 Browse to the sample file and select it.

3 In the Resource Type Settings dialog, select Sample.

4 Add the sapgof2lxf.gofcfg file to the resource set by right-clicking the 
Resources folder and select Import.

5 Browse to the configuration file and select it. The file is by default located 
in <StreamServe installation>
\Applications\Streamserver\<version>\Common\data\output+

6 In the Resource Type Settings dialog, select OutputPlus Configuration.

7 Open the PreformatIN Event.

Sample file extension (*.gof) 

Ensure that the extension of the file is .gof. If the file has another 
extension, you will not be able to import the file into the PreformatIN 
tool, and the file will not automatically be converted to LXF format.
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8 Select File > Open Sample. The Select Resource dialog opens.

9 Locate and select the Resource Set with the sample.

10 Browse to the sample file and double-click it. The Filter options dialog 
opens.

11 In the Configuration field, browse to the outputplus configurations folder 
and select the sapgof2lxf.gofcfg file.

Identifying and extracting SAPGOF data
The minimum configuration required for a PreformatIN Event for SAPGOF data, 
is a unique pattern that identifies the type of Form or Report. 

If you want to reformat the layout of the data, you can use PreformatIN in the 
standard way, including mapping blocks and fields to capture data. See the 
PreformatIN documentation.

Saving SAPGOF data as a dynamic overlay
In the PreformatIN tool, you can save an imported SAPGOF file as a dynamic 
overlay in the Dynamic Resources repository. 

Prerequisites

Before you save a Form or Report as a dynamic overlay, you must configure the 
Dynamic Resources repository in the Platform in Design Center. For information 
about the repository properties, see the Design Center documentation.

To save SAPGOF data as a dynamic overlay

1 On the PreformatIN sheet, display the page that you want to save as a 
dynamic overlay.

2 Select Tools > Options. The Options dialog box opens.

3 Select Use dynamic overlay.

4 Click OK.

For more information about dynamic overlays, see the PreformatIN 
documentation.
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Defining a Process for SAPGOF data
When using Design Center to create a Message for OTF (Form) or ABAP List 
(Report) data, you configure the Message using a PreformatIN Event, and any 
Process tool for designing the layout. To re-use the layout of the Form or Report, 
you must use PageOUT.

This section describes how to add a dynamic overlay to a PageOUT Process. For 
information about configuring other types of Processes, see the relevant Process 
tool documentation.

Prerequisites

Before you add the dynamic overlay to the output, you must save the Form or 
Report as a dynamic overlay in the PreformatIN Event. See Saving SAPGOF data 
as a dynamic overlay on page 28.

To add a dynamic overlay

1 Add a PageOUT Process to the Message.

2 Open the PageOUT Process.

3 Select Edit > Add Overlay. The Add Overlays dialog box opens.

4 From the Overlay list, select the dynamic overlay for the Form.

5 Click OK. The dynamic overlay for the Form opens on the PageOUT sheet.
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Configuring Runtime for SAPGOF 
data

This chapter describes how to configure a recommended Runtime configuration 
for SAPGOF data using Design Center.

For more information on Runtime configurations, see the Design Center 
documentation.

The Runtime configuration specific to the Output+ Connect solution, is the 
SAPGOFIN filter used in a Filter Chain.

Note: Instead of adding the SAPGOFIN in the Runtime configuration, you can 
add the filter to the input connector in the Platform. However, adding the 
filter in the Runtime configuration is the recommended method.

Included activities

• Configuring the SAPGOFIN filter on page 32

• Configuring Runtime for Form or Report Messages on page 33

The SAPGOFIN filter
For StreamServer to recognize and handle SAPGOF data, a SAPGOFIN filter is 
used at runtime to convert SAPGOF data into LXF (Layout eXchange Format).

For information about Filter Chains, see the Design Center documentation.
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Configuring the SAPGOFIN filter
To configure the SAPGOFIN filter

1 Select or create the resource set for the Message.

2 Add a Filter Chain to the resource set and open the Filter Chain.

3 Right-click in the Filter Chain editor, and select Add Filter >SAPGOFIN.

4 Browse to and select the sapgof2lxf.gofcfg file.

5 Save and close the Filter Chain editor. 

To select the SAPGOFIN filter on the input connector

1 In the Platform configuration, right-click the input connector, and select 
Settings. The Input Connector Settings dialog opens.

2 Click the Filter Chain button. The Browse for Resources dialog opens.

3 Browse to the filter chain folder, and select the filter chain configured for 
the SAPGOFIN and Codepage filters.

4 Click OK.
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Configuring Runtime for Form or Report 
Messages

To configure Runtime for Form or Report Messages

1 In Design Center, create a new Runtime configuration connected to the 
Platform you created. 

2 Right-click the Job of the Runtime configuration, and select Add Message. 
The Select Messages dialog box opens. 

3 Select the Message containing the Report you want to add to the Job, and 
click OK.
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The SAPGOFIN configuration file

The SAPGOFIN configuration file (sapgof2lxf.gofcfg) is by default located in 
<StreamServe installation>

\Applications\Streamserver\<version>\Common\data\output+. 

This file is used by the SAPGOFIN filter to convert SAPGOF data to LXF. The 
LXF data is then sent to StreamServer for further processing.

To benefit from the SAPGOFU device type, use Unicode enabled 
fonts.
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Modifying the SAPGOFIN configuration file
The configuration file consists of different sections that you can modify to suit 
your installation. 

common section
The common section applies to both OTF and ABAP list data.

otf section
The otf section applies to OTF (Form) data only. It includes default values for 
processing SAP Forms (OTF data).

conversion properties

mapping-file The path to ssmbyte.dat file required to map SAP multi-
byte characters. For example:

<StreamServe installation>
\Applications\StreamServer\<version>\Common
\data\ssmbyte.dat

mode The filter mode. Either otf, abaplist, or both. Default is 
both.

defaults properties

outputshift The amount of shift to the right for the SAPGOFIN output. 
See PostScript drivers and the SAPGOF output device on 
page 125.

font The default font. If there is no mapping specified for the 
SAP font, the default font is used. For example courier.
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The SAPGOFIN configuration file
settings properties

STAppendMode When input data contains Unicode text, fields can in 
some cases overlap each other and horizontal lines 
can be printed in the right margin. To avoid this, 
specify yes. This means that consecutive ST 
commands will be concatenated into one single 
label.

Consider the following data example:

SW00092

ST0296058String_one

ST0289560String_two

SW00054

ST0241850String_three

Specifying yes will concatenate String_one, 
String_two, and String_three since SW 
commands are by default ignored. To alter this 
behavior, see the STAppendModeSkipSw property.

The default value of STAppendMode is no, meaning 
that:

• Strings are not concatenated and SW values 
are considered.

• The property is set to no if the option is 
missing from the configuration file.

STAppendModeSkipSw If the this property is set to yes, or is not specified, 
Space Width commands are ignored and strings are 
concatenated even if there are SW commands in 
between.

Note: This requires that StAppendMode=yes.

Specify no to consider the Space Width values in 
your input data. If STAppendMode=yes, consecutive 
ST commands between SW commands are 
concatenated. In the STAppendMode example, 
String_one and String_two will be concatenated, 
but not String_three.

The default value is yes, meaning that the property 
is set to yes if the option is missing from the 
configuration file.
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The SAPGOFIN configuration file
barcodes section
The barcodes section applies to OTF (Form) data only. It includes values for 
standard barcodes. Each barcode is identified with the name used in the SAP 
system.

abaplist section
The abaplist section applies to ABAP list data only. It includes default values 
for processing SAP Reports (ABAP list data). The abaplist section is divided in 
two sections — defaults and listcolors.

variables properties

exclude-from-
overlay

When input data contains Unicode text, fields can in some 
cases overlap each other and horizontal lines can be printed 
in the right margin. To avoid this, specify yes.

sapname properties
(Where sapname is the name of the barcode in the SAP system.)

strsname Name of the barcode in StreamServe.

height Height of the barcode.

checkchar The number of a character used to check that the barcode 
has been entered correctly.

printtext Specifies whether or not the text is to be printed. Values are 
Yes or No. 

rotation Specifies the angle of rotation (in degrees) for the barcode, 
for example 90. 

modulesize The minimum width in millimeters of a bar in the barcode.

alignbottom Specifies if the barcode bottom is aligned with the 
character baseline. By default set to yes.

If set to no, the barcode top is aligned with the baseline.

defaults properties

paper The paper size, such as A4 or Letter.

format The output (page) format, indicating the maximum number 
of lines and columns per printed page. For example 
X_65_80 is 65 rows and 80 columns.
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listcolors properties
The listcolors properties apply to ABAP list data only.

SAP uses standard print controls to specify the foreground (font) color and 
background color of ABAP List data. For a list of color print controls, see Print 
controls for color control in ABAP List data on page 57. 

The default foreground and background colors are pre-configured in the 
configuration file. If you require additional colors for a print control, you can 
modify the color value (RGB value).

font The default font to be used. For example courier.

replacement-char SAPGOF data can contain references to SAPGOF 
characters. SAPGOF characters are written with a hash 
symbol “#” and a 3-digit code, (eg. #251), or with an ‘at’ 
symbol “@” and a 4-digit code (eg.@1024).

For example:

MT0100809360
ST0475233Terms of delivery   #251 EXW Broadview

If the referenced character is missing, the replacement-
char character will be used instead. 

If the OTF data from your SAP system contains references 
to SAPGOF characters, symbol.map will map the 
SAPGOF characters included in the data to one of the 
following:

• a character in the current font (given in decimal)

251 0223

• a bitmap

251 bitmaps/xyz.bmp

• a character in another font

251 FONT 0044 Wingdings

• a default value

DEFAULT 0032

The symbol.map file maps SAPGOF characters to the 
corresponding characters in the ISO 8859-1 (Latin 1) 
character set. The file also provides mappings for all SAP 
icons. 

additional- 
linespacing

Extra line spacing in points. Line spacing is specified for 
each page format. If page format line spacing is missing, 
the line spacing is equal to font size.

defaults properties
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The foreground and background color are specified using the following format:

COLnx foreground_color, background_color, style

Where: 

• COLnx specifies a standard print control in ABAP List data, where: 

– COL is a fixed prefix to identify the print control as a color control 

– n specifies the color number (0-7) 

– x specifies the type (N = normal, H = highlighted, V = inverted). 

• foreground_color and background_color specify the foreground (font) color 
and background color as a RGB value. For example, 0:0:0 for black and 
0:0:255 for blue.

• style can be one of the following values: 

– N (normal) 

– B (bold) 

– I (italic) 

– IB (italic bold) 

Example 1 listcolor property

<property id=”COL6H”>0:0:0,238:0:0,B</property>

List color transparency properties

You can use this option to avoid that e.g. the bottom parts of letters like g and p 
are cut off when text is printed black on white background.

transparency Set to yes to let all color definitions in the transparency-
for list have a transparent background.

transparency-for A comma-separated list of colors whose background is 
transparent if transparency is set to yes. For example:

<property id=

"transparency-for">COL0N,COL0H,COL1N,COL4H</
property>

You can use an asterisk if you want all background colors 
to be transparent:

"transparency-for">*</property>
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paper section
The paper section applies to ABAP data only. It specifies the page type and size.

pageformats section
The pageformats section applies to ABAP data only. It specifies page format and 
orientation.

Specifying font for a page format
You can use a specific font for a specific page format, by adding a font property 
into the page format property bag. If no font is specified, the font specified in the 
defaults property bag is used. See Example 2 on page 41.

Example 2 Specifying font for a page format

<section type="pageformats">

            <propertybag id="X_44_120">

                        <!--The SAP page orientation definition.-->

paper properties

paper type The size of the paper for the Report. For example A4.

width The width of the page in millimeters. For example 297 (for 
an A4 page).

height Height of the page in millimeters. For example 420 (for an 
A4 page).

pageformat properties

orientation The page orientation of the Report. Valid values are:

• landscape

• portrait

marginleft The width of the left margin in millimeters. 

margintop The width of the top margin in millimeters.

rows The number of rows in the Report.

columns The number of columns in the Report.

fontsize The default font size that should be used.

linespacing The line spacing to use for the page format.

Note: For backwards compatibility: If the value is 
missing, the fontsize value is used.
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                        <property id="orientation">landscape</property>

                        <property id="marginleft">10</property>

                        <property id="margintop">10</property>

                        <property id="rows">44</property>

                        <property id="columns">120</property>

                        <property id="fontsize">8</property>

                        <property id="font">COURIER</property>

            </propertybag>

fonts section
The fonts section maps the internal SAP font name to a StreamServe font name. 
When the SAPGOFIN filter process the data, all fonts used in the data stream are 
mapped to a StreamServe font name according to the fonts section in the 
configuration file. The data is then passed to StreamServer for further processing.

Mapping special characters
You can use special characters in the SAPGOF data by mapping them to 
characters in StreamServe fonts.

Note: The sapgof2lxf.gofcfg configuration file converts the "hook", "fork" 
and "chair" characters in the SAP OCRA font, to corresponding characters 
in the StreamServe OCR-A font.

To map a special character, you must:

• Identify the SAP font, codepage and character code for the character to 
convert.

• Identify which character that corresponds to the SAP character code.

• Identify the character code in the StreamServe font, by using for example 
the Windows Character Map application.

• Identify the cell2char value for the StreamServe font.

• Edit the sapgof2lxf.gofcfg file.

font properties

font Name of the font in the SAP system.

strsname Name of the font in StreamServe.

cell2char The cell value for a character.

charwidth The width of the character (only used for ABAP List data).
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To identify the character, font and codepage

1 The character code for the character to convert is specified in the 6th and 
following numbers in the CH command.

2 The codepage is specified in the last CP command occurring before the CH 
command in the 4 first numbers after CP.

3 The font is specified in the first FC command occurring after the CP 
command but before the CH command.

Example 3 Excerpt from a SAPGOF file

In the following example the character code is 165, the SAP codepage is 4102, 
and the SAP font is HELVE

CP41020000D
FCHELVE    100  00084X         410200056
ST0201614  0000110000001
CH00144165

To identify which character corresponds to the SAP character code

1 Log on to the SAP system.

2 In the transaction box, enter /nspad. The initial Spool Administration 
window opens.

3 Select Utilities > For character sets > Output character set

4 Enter the codepage and click Execute.

5 Identify which character that corresponds to the character code specified in 
the CH command in the SAPGOF data.

To identify the StreamServe character code

1 Start the Character Map application in Windows (Accessories > System 
Tools > Character Map). (Or run charmap in command line)

2 Select the StreamServe font and character to use.

3 Convert the displayed unicode hex value to a decimal value. For example, if 
U+0021 is displayed, convert hex(21) to the decimal value (33).

To identify the cell2char value

1 Create an overlay containing text in the StreamServe font to use.

2 Open the overlay LXF file in a text editor.

3 Identify the cell2char value for the StreamServe font.

See example Example 4 on page 43.

Example 4 cell2char value

A StreamServe font with cell2char value 0.895.
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<font id="6" name="Arial" size="12.4533,pt" cell2char="0.895" 
ptsize="11.0"/>

To edit the sapgof2lxf.gofcfg file

To map the character code in the OTF input file to the corresponding character 
code in the font file, you must make an entry the sapgof2lxf.gofcfg file. See 
Example 5 on page 44.

Example 5 An entry for a character mapping

In the following example the Yen symbol in SAP font Helvetica is converted to 
the Euro symbol in StreamServe font Arial.

<propertybag id="HELVE">

  <property id="strsname">

    <!--StreamServe font name-->Arial</property>

  <property id="cell2char">

    <!--The cell value for the character-->0.895</property>

  <property id="CH_165">

    <!--maps character 165 (Yen symbol) to Euro symbol-->8364</
property>

  </propertybag>
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StreamServe and OTF data

SAPGOF (SAP Generic Output Format) is an internal SAP format created using 
the SAPGOF printer driver. SAPGOF data is written in ASCII format and 
contains a descriptive header and header variables. 

OTF data is created by the SAPscript Composer and Smart Forms in SAP.

Example 1 SAPGOF data in OTF format

The following data is a sample of SAPGOF data in OTF format:

Note: This graphic has been cropped and does not display all records.
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OTF data variables
You can use the following types of variables with OTF formatted SAPGOF data:

• SAPGOF header variables on page 46

• Pre-defined Form variables on page 47

• variables defined in script functions (see Scripting Reference).

If you are using the Project tool with version 3.01 of StreamServe or earlier, you 
can clear all variables on a page in a Form using the Clear All Page Variables 
option, see Clearing variables on page 102.

SAPGOF header variables
All values in the header of a SAPGOF data file can be used as variables in 
StreamServer. See Header records on page 48.

Note: Variables that refer to SAPGOF header data are read-only, and you cannot 
change their value using a script. 

Example 2 SAPGOF header variables for OTF data

The *FORMAT variable indicates that the data is OTF (Form) data. 

*MAJOR=2
*MINOR=1
*FORMAT=OTF
*RQID=24909
*RQOWNER=IMJSC
*RQCLIENT=800
*RQCREATIME=17.08.1999 17:58:57
*RQNAME=SD_009
*RQSUFFIX1=RD00
*RQSUFFIX2=INVOICE
*RQORIGDEST=KUB0
*DVCODEPAGE=4010
*DVDEVTYPE=SAPGOF
*DVORIGDEVTYPE=SAPGOF
*PJAMOUNT=1
*PJCLIENT=800
*PJDEPARTMENT=
*PJFORM=DINA4
*PJJOBNO=1
*PJLAUNCHED=17.08.1999 17:58:58
*PJENDPAGE=0
*PJSTRTPAGE=0
*PJTELENUM=
*PJPRINTER=XYZ123
*PJPRIO=3
*PJRECEIVER=D000195
*PJTITLE=
*PJUSER=IMJSC
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Pre-defined Form variables
The SAPGOFIN filter generates pre-defined variables which can be used by 
StreamServer.

Note: For a list of header variables, see Header records on page 48.

Example 3 Pre-defined Form variables

$pj_doclanguage=D

$pj_doctrigger=NEXT

$pj_orientation=Portrait

$pj_printmode=Simplex

Variable Description

$pj_doclanguage The language used in the SAPGOF data. For example D 
(German).

$pj_doctrigger The page name of the Form, such as FIRST or NEXT.

$pj_formname The name of the SapScript or SmartForm that generated 
the OTF data.

$pj_orientation The page orientation of the Form. Valid values are:

• Landscape

• Portrait

$pj_printmode The layout of the printed Form. Valid values are:

• Simplex

• Duplex Long-edge

• Duplex Short-edge

• None
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OTF records
SAPGOF data is divided into two sections or ‘records’. These records are:

• Header records (identified with an initial * character)

• Data records.

Header records
Header records contain information about the SAP spool request and output 
request. The information is specified in variables (identified with *) using the 
format ‘variable=value’. 

For information on using variables, see SAPGOF header variables on page 46.

The following variables are currently used (SAP 4.6c):

Variable Name Description Fixed 
Length

*MAJOR Main version number. 1

*MINOR Sub-version number. 1

*FORMAT Data format: For Form data, the variable is set to 
OTF, for ABAP List data the variable is set to LIST.

-

*RQID Spool request number. -

*RQOWNER User who created the spool request. 12

*RQCLIENT Client in which the spool request was created. 3

*RQCREATIME Creation time of the spool request. 16

*RQNAME First part of the three-part spool request name. 6

*RQSUFFIX1 Second part of the three-part spool request name. 4

*RQSUFFIX2 Third part of the three-part spool request name. 12

*RQORIGDEST Original output device for spool request. 4

*DVCODEPAGE Character set number of the device type for the 
output request.

4

*DVDEVTYPE Device type of output device *PJPRINTER. 8

*DVORIGDEVTYPE Device type of the original output device 
*RQORIGDEST.

4

*PJAMOUNT Number of copies. 3

*PJCLIENT Client in which the output request was created. 3
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Data records
Data records contain the actual user data in the following structure:

• Command ID (2 characters)

• Command parameters (variable length)

• ASCII control character NEWLINE (1 character).

Command ID
The command ID consists of two characters which identify the content and 
function of the data line. The following command IDs are available:

*PJDEPARTMENT Department of output request recipient. 12

*PJFORM Formatting type for the output request. 16

*PJJOBNNO Output request number. -

*PJLAUNCHED Creation time of the spool request. 16

*PJENDPAGE Number of the last page of the spool request to be 
printed.

-

*PJSTRTPAGE Number of the first page of the spool request to be 
printed.

-

*PJTELENUM Fax number for fax requests. 30

*PJPRINTER Output device for output request. 4

*PJPRIO Output request priority (1= high, 9 = low). 1

*PJRECEIVER Output request recipient. 12

*PJTITLE Title of the output request. 86

*PJUSER User who created the output request. 12

Variable Name Description Fixed 
Length

ID Name Description

OP Open Page First command on page. Specifies page 
properties, such as format and orientation.

EP End Page Close - last command on page.

MT Move To Sets the cursor (the current output position) to 
a position on the output page. The reference 
point is the top-left page corner.
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Command Parameters 
For some commands, such as MT, the parameters are of fixed length, while for 
other commands, such as ST, can be of variable length. If the parameter area is of 
variable length, the length is defined by a parameter.

For more information on SAPGOF command parameters, see your SAP reference 
material.

ST String Character string

FC Font Call Font properties including family and size.

BC(BS) Bar Code Bar code output

UL Underline Underline

SW Space Width Space character width

SU Superscript/Subscript Superscript /subscript

CP Code Page Switch code page

CH Character SAP Character

MK Marked Selected text for display

RD Raw Data Printer-specific data

MC Microfiche Cold Microfiche cold identification

PC Print Control Print control from T022D

BX Box Box character

IN Information Form information (including the name of the 
SAPscript Form).

BM Bitmap Bitmap information

CB Color Box Color box

CT Color Text Color text

LI Line Line

LB Link Begin Link Begin

LE Link End Link End

LK Link Link

RT Raw Text Raw text

ID Name Description
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End of line
The structure of SAPGOF data is line-oriented, with each line concluding with a 
special identifier. This can vary according to the variant of the SAPGOF data flow 
(ASCII, EBCDIC). In the ASCII version of the SAPGOF format, which 
StreamServe uses, it is the ASCII-NEWLINE (hex $0A).
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SAPGOF (SAP Generic Output Format) is an internal SAP format created using 
the SAPGOF printer driver. SAPGOF data is written in ASCII format and 
contains a descriptive header and header variables. 

ABAP List data is generated by the ABAP/4 language directly from the SAP 
system.

Example 1 SAPGOF data from an ABAP List report

Note: This graphic has been cropped and does not display all records.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A



54 ABAP List data variables
StreamServe and ABAP List data
ABAP List data variables
You can use the following types of variables with ABAP List data:

• SAPGOF header variables on page 54

• variables defined in script functions (see Scripting Reference).

SAPGOF header variables
All values in the header of a SAPGOF data can be used as variables in 
StreamServer. You reference SAPGOF header variables in script functions as 
$<varname>. For example:

$pj_printmode

Note: Variables which refer to SAPGOF header data are read-only - you cannot 
change their value using a script function. 

For a list of header records in ABAP List data, see Header records on page 55.

Example 2 SAPGOF header for ABAP List data

The *FORMAT variable indicates whether the data is OTF data or ABAP List 
data.The following is a sample SAPGOF header for ABAP List data:

*MAJOR=2
*MINOR=1
*FORMAT=LIST
*RQID=24909
*RQOWNER=IMJSC
*RQCLIENT=800
*RQCREATIME=17.08.1999 17:58:57
*RQNAME=SD_009
*RQSUFFIX1=RD00
*RQSUFFIX2=INVOICE
*RQORIGDEST=KUB0
*DVCODEPAGE=4010
*DVDEVTYPE=SAPGOF
*DVORIGDEVTYPE=SAPGOF
*PJAMOUNT=1
*PJCLIENT=800
*PJDEPARTMENT=
*PJFORM=DINA4
*PJJOBNO=1
*PJLAUNCHED=17.08.1999 17:58:58
*PJENDPAGE=0
*PJSTRTPAGE=0
*PJTELENUM=
*PJPRINTER=XYZ123
*PJPRIO=3
*PJRECEIVER=D000195
*PJUSER=IMJSC
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ABAP List data records
SAPGOF data is divided into two sections or ‘records’. These records are:

• Header records (identified with an initial * character)

• Data records.

Header records
Header records contain information about the SAP spool request and output 
request. The information is specified in variables (identified with *) using the 
format ‘variable=value’. 

For information on using variables, see SAPGOF header variables on page 54.

The following variables are currently used (SAP 4.6c):

Variable Name Description Fixed 
Length

*MAJOR Main version number. 1

*MINOR Sub-version number. 1

*FORMAT Data format: For Form data, the variable is set to 
OTF, for ABAP List data the variable is set to LIST.

-

*RQID Spool request number. -

*RQOWNER User who created the spool request. 12

*RQCLIENT Client in which the spool request was created. 3

*RQCREATIME Creation time of the spool request. 16

*RQNAME First part of the three-part spool request name. 6

*RQSUFFIX1 Second part of the three-part spool request name. 4

*RQSUFFIX2 Third part of the three-part spool request name. 12

*RQORIGDEST Original output device for spool request. 4

*DVCODEPAGE Character set number of the device type for the 
output request.

4

*DVDEVTYPE Device type of output device *PJPRINTER. 8

*DVORIGDEVTYPE Device type of the original output device 
*RQORIGDEST.

4

*PJAMOUNT Number of copies. 3

*PJCLIENT Client in which the output request was created. 3
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A



56 ABAP List data records
StreamServe and ABAP List data
Data records
Data records contain the actual user data in the following structure:

• Command ID (2 characters)

• Command parameters (optional and variable length)

The command ID consists of two characters that identify the content and function 
of the data line. The following command IDs are available:

For information on SAPGOF command parameters, see your SAP reference 
material.

*PJDEPARTMENT Department of output request recipient. 12

*PJFORM Formatting type for the output request. 16

*PJJOBNNO Output request number. -

*PJLAUNCHED Creation time of the spool request. 16

*PJENDPAGE Number of the last page of the spool request to be 
printed.

-

*PJSTRTPAGE Number of the first page of the spool request to be 
printed.

-

*PJTELENUM Fax number for fax requests. 30

*PJPRINTER Output device for output request. 4

*PJPRIO Output request priority (1= high, 9 = low). 1

*PJRECEIVER Output request recipient. 12

*PJTITLE Title of the output request. 86

*PJUSER User who created the output request. 12

Variable Name Description Fixed 
Length

ID Name Description

SP Start Page Start a new page

LD Line Data Characters to be output (variable length)

PC Print Control Name of print control (length is 5)

EL End of Line End of line

EP End of Page End of page
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Print controls for color control in ABAP List data
Data records in ABAP List data can include a range of print controls which 
control the foreground (font) color and background color.

These print controls are named as:

COLnx

Where:

• COL is a fixed prefix to identify the print control as a color control

• n specifies the color number (0-7)

• x specifies the control type (N = normal, H = highlighted, V = inverted).

The following color print controls are available:

Print control Foreground color Background color

COL0N Black Gray

COL0H Blue Gray

COL0V Gray Blue

COL1N Black Pale blue

COL1H Black Blue

COL1V Blue Gray

COL2N Black White

COL2H Black Pale Gray

COL2V Dark gray Gray

COL3N Black Pale yellow

COL3H Black Yellow

COL3V Yellow Gray

COL4N Black Pale turquoise

COL4H Black Turquoise

COL4V Turquoise Gray

COL5N Black Pale green

COL5H Black Green

COL5V Green Gray

COL6N Black Pale red

COL6H Black Red
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Print controls in the SAPGOFIN configuration file
The default foreground and background colors are preconfigured in the 
SAPGOFIN configuration file (sapgof2lxf.gofcfg). The file contains default 
report information that StreamServe uses to the process ABAP List data.

If you require additional colors, you add the print control settings directly to the 
SAPGOFIN configuration file. See The SAPGOFIN configuration file on page 
35.

Frame characters
ABAP List data produced by SAP can contain frame characters. Frame characters 
are special characters used to output pseudo-graphics.

Frame characters in ABAP List data are represented by the character combination 
#XXX, where XXX represents the three-digit SAP number for the characters. 

For frame characters #460-#474, the SAPGOFIN filter uses the font character to 
produce the correct output. For example:

For Frame characters #474 and #475, the SAPGOFIN filter reference these 
bitmaps. 

• checkbox_off.bmp

• checkbox_on.bmp

If you want to use any of these bitmap files, add them to the Design Center 
resource set.

Symbols and icons
SAPGOF data can contain references to SAPGOF characters. SAPGOF 
characters are written with a hash symbol “#” and a 3-digit code, (for example 
#251), or with an ‘at’ symbol “@” and a 4-digit code (for example @1024).

For example:

COL6V Red Gray

COL7N Black Pale purple

COL7H Black Purple

COL7V Purple Gray

Print control Foreground color Background color

Character combination in data SAP character name

#460 box_drawings_light_horizontal
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MT0100809360
ST0475233Terms of delivery   #251 EXW Broadview

If the ABAP list data contains references to SAPGOF special characters, the 
SAPGOFIN filter will map the character to either a font or a bitmap. The setup 
will install these bitmaps to the following directory:

<StreamServe installation>
\Applications\StreamServer\<version>\Common\data\output+

To use any of these bitmaps, import them to the resource set.

Replacing a SAP character with another bitmap

If you want to replace a SAP character identified with a hash symbol “#” and a 3-
digit code, with another bitmap, you have to identify the bitmap for the SAP 
character that you want to replace. 

For example, if you want to replace the #673 SAP character, you will have to 
identify the bitmap name for the character, sapding21.bmp and replace the 
bitmap with the replacement bitmap, for example, newbmp.bmp.

These bitmaps are located in the following directory:

<StreamServe installation>
\Applications\StreamServer\<version>\Common\data\output+

For a list of SAP characters and corresponding bitmaps, see SAP characters and 
icons on page 61.
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SAPGOF data can contain references to SAPGOF characters. SAPGOF 
characters are written with a hash symbol “#” and a 3-digit code, (eg. #251), or 
with an ‘at’ symbol “@” and a 4-digit code (eg.@1024).

For example:

MT0100809360
ST0475233Terms of delivery   #251 EXW Broadview

If the ABAP list data contains references to SAPGOF special characters, the 
SAPGOFIN filter will map the character to either a font or a bitmap. The setup 
installs these bitmaps to the following directory:

<StreamServe installation>
\Applications\StreamServer\<version>\Common\Data\Output+

To use any of these bitmaps, import them to the resource set as images.

Note: If you do not import the bitmaps to the resource set, then the sapgof filter 
will search for the pre-installed default bitmaps and icons from the 
location above. This means that you only need to import the bitmaps if 
you want to override the default.

Replacing a SAP character with another bitmap

If you want to replace a SAP character identified with a hash symbol “#” and a 3-
digit code, with another bitmap, you have to identify the bitmap for the SAP 
character that you want to replace. 

For example, if you want to replace the #673 SAP character, you will have to 
identify the bitmap name for the character, sapding21.bmp and replace the 
bitmap with the replacement bitmap, for example, newbmp.bmp.
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SAPding bitmaps
These SAPding bitmaps are located in the following directory:

<StreamServe installation>

\Applications\StreamServer\<version>\Common\Data\Output+\sapdings

SAP 
character

SAPding bitmap SAP 
character

SAPding bitmap

673 sapding21.bmp 706 sapding42.bmp

674 sapding22.bmp 707 sapding43.bmp

675 sapding23.bmp 708 sapding44.bmp

676 sapding24.bmp 709 sapding45.bmp

677 sapding25.bmp 710 sapding46.bmp

678 sapding26.bmp 711 sapding47.bmp

679 sapding27.bmp 712 sapding48.bmp

680 sapding28.bmp 713 sapding49.bmp

681 sapding29.bmp 714 sapding4A.bmp

682 sapding2A.bmp 715 sapding4B.bmp

683 sapding2B.bmp 716 sapding4C.bmp

684 sapding2C.bmp 717 sapding4D.bmp

686 sapding2E.bmp 718 sapding4E.bmp

687 sapding2F.bmp 719 sapding4F.bmp

688 sapding30.bmp 720 sapding50.bmp

689 sapding31.bmp 721 sapding51.bmp

690 sapding32.bmp 722 sapding52.bmp

691 sapding33.bmp 723 sapding53.bmp

692 sapding34.bmp 724 sapding54.bmp

693 sapding35.bmp 725 sapding55.bmp

694 sapding36.bmp 726 sapding56.bmp

695 sapding37.bmp 727 sapding57.bmp

696 sapding38.bmp 728 sapding58.bmp

697 sapding39.bmp 

698 sapding3A.bmp 

699 sapding3B.bmp 

700 sapding3C.bmp 

701 sapding3D.bmp 

702 sapding3E.bmp 

703 sapding3F.bmp 
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705 sapding41.bmp

SAP 
character

SAPding bitmap SAP 
character

SAPding bitmap
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SAP icon bitmaps
These icon bitmaps are located in the following directory:

<StreamServe installation>

\Applications\StreamServer\<version>\Common\Data\Output+\sapicons

SAP 
character

Icon bitmap SAP 
character

Icon bitmap

768 s_b_dumy.bmp 799 s_b_okay.bmp

769 s_s_okay.bmp 800 s_b_canc.bmp

770 s_s_nono.bmp 801 s_b_prnt.bmp

771 s_s_erro.bmp 802 s_b_crea.bmp

772 s_s_posi.bmp 803 s_b_chng.bmp

773 s_s_nega.bmp 804 s_b_disp.bmp

774 s_s_locl.bmp 805 s_b_dele.bmp

775 s_s_loop.bmp 806 s_b_test.bmp

776 s_s_tl_g.bmp 807 s_b_srch.bmp

777 s_s_tl_y.bmp 808 s_b_copy.bmp

778 s_s_tl_r.bmp 809 s_b_exec.bmp

779 s_b_totl.bmp 810 s_b_detl.bmp

780 s_b_totr.bmp 811 s_b_insr.bmp

781 s_b_coll.bmp 812 s_b_delr.bmp

782 s_b_colr.bmp 813 s_m_info.bmp

783 s_b_pagr.bmp 814 s_m_warn.bmp

784 s_b_pagl.bmp 815 s_m_erro.bmp

785 s_b_prvi.bmp 816 s_m_ques.bmp

786 s_b_nxti.bmp 817 s_m_crit.bmp

787 s_b_anno.bmp 818 s_bgmore.bmp

788 s_b_nocr.bmp 819 s_b_more.bmp

789 s_b_nodp.bmp 820 s_b_equa.bmp

790 s_b_calc.bmp 821 s_b_nequ.bmp

791 s_b_graf.bmp 822 s_b_grea.bmp

792 s_b_txcr.bmp 823 s_b_less.bmp

793 s_b_txdp.bmp 824 s_b_greq.bmp

794 s_b_text.bmp 825 s_b_leeq.bmp

795 s_b_vari.bmp 826 s_b_ivin.bmp

796 s_b_info.bmp 827 s_b_ivex.bmp

797 s_b_addr.bmp 828 s_b_patt.bmp
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798 s_b_opta.bmp 829 s_b_npat.bmp

830 s_t_phon.bmp 865 s_f_prnt.bmp

831 s_t_tfax.bmp 866 s_f_oobj.bmp

832 s_t_mail.bmp 867 s_f_prvo.bmp

833 s_t_time.bmp 868 s_f_nxto.bmp

834 s_t_date.bmp 869 s_f_cuto.bmp

835 s_t_alar.bmp 870 s_f_copy.bmp

836 s_t_pros.bmp 871 s_f_past.bmp

837 s_t_vide.bmp 872 s_f_undo.bmp

838 s_t_voic.bmp 873 s_f_mark.bmp

839 s_t_soun.bmp 874 s_f_fstp.bmp

840 s_bgequa.bmp 875 s_f_prvp.bmp

841 s_bgnequ.bmp 876 s_f_nxtp.bmp

842 s_bggrea.bmp 877 s_f_lstp.bmp

843 s_bgless.bmp 878 s_f_mocr.bmp

844 s_bggreq.bmp 879 s_f_mode.bmp

845 s_bgleeq.bmp 880 s_f_user.bmp

846 s_bgivin.bmp 881 s_f_help.bmp

847 s_bgivex.bmp 882 s_b_tvar.bmp

848 s_bgpatt.bmp 883 s_b_repl.bmp

849 s_bgnpat.bmp 884 s_b_chck.bmp

850 s_brequa.bmp 885 s_b_genr.bmp

851 s_brnequ.bmp 886 s_b_book.bmp

852 s_brgrea.bmp 887 s_b_chip.bmp

853 s_brless.bmp 888 s_b_acti.bmp

854 s_brgreq.bmp 889 s_b_icon.bmp

855 s_brleeq.bmp 890 s_b_srtu.bmp

856 s_brivin.bmp 891 s_b_srtd.bmp

857 s_brivex.bmp 892 s_b_layt.bmp

858 s_brpatt.bmp 893 s_b_conv.bmp

859 s_brnpat.bmp 894 s_b_dpch.bmp

860 s_f_okay.bmp 895 s_b_stat.bmp

861 s_f_save.bmp 940 s_b_prvn.bmp

862 s_f_back.bmp 941 s_b_nxtn.bmp

863 s_f_endt.bmp 942 s_b_tree.bmp

SAP 
character

Icon bitmap SAP 
character

Icon bitmap
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864 s_f_canc.bmp 943 s_b_insn.bmp

944 s_b_fdat.bmp 979 s_f_cutl.bmp

945 s_b_head.bmp 980 s_f_copl.bmp

946 s_b_oviw.bmp 981 s_f_pasl.bmp

947 s_b_dail.bmp 982 s_f_mrkl.bmp

948 s_b_expa.bmp 983 s_f_redo.bmp

949 s_b_cols.bmp 984 s_b_bnpr.bmp

950 s_s_brkp.bmp 985 s_b_bnpa.bmp

951 s_b_fkey.bmp 986 s_b_bnso.bmp

952 s_b_list.bmp 987 s_b_bnsz.bmp

953 s_b_clos.bmp 988 s_b_bnbo.bmp

954 s_b_posn.bmp 989 s_b_bnid.bmp

955 s_b_summ.bmp 990 s_b_bnet.bmp

956 s_b_move.bmp 991 s_b_bnpv.bmp

957 s_b_retr.bmp 992 s_b_bncd.bmp

958 s_b_refr.bmp 993 s_b_bndm.bmp

959 s_b_skip.bmp 994 s_b_alig.bmp

960 s_f_sett.bmp 995 s_b_cutn.bmp

961 s_b_tool.bmp 996 s_b_fixc.bmp

962 s_b_comp.bmp 997 s_b_relc.bmp

963 s_b_sndn.bmp 998 s_b_netg.bmp

964 s_b_uplo.bmp 999 s_b_plan.bmp

965 s_b_down.bmp 1000 s_b_peri.bmp

966 s_b_trns.bmp 1001 s_b_zoin.bmp

967 s_b_mrka.bmp 1002 s_b_zout.bmp

968 s_b_mrkb.bmp 1003 s_s_ledg.bmp

969 s_b_mrkd.bmp 1004 s_s_ledr.bmp

970 s_b_srcc.bmp 1005 s_s_ledy.bmp

971 s_b_renm.bmp 1006 s_f_ehlp.bmp

972 s_b_filt.bmp 1007 s_b_spce.bmp

973 s_b_nlev.bmp 1008 s_b_bnwk.bmp

974 s_b_plev.bmp 1009 s_b_akti.bmp

975 s_f_inpv.bmp 1010 s_b_bedi.bmp

976 s_b_inte.bmp 1011 s_b_bent.bmp

977 s_b_prsh.bmp 1012 s_b_cont.bmp

SAP 
character

Icon bitmap SAP 
character

Icon bitmap
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978 s_b_varb.bmp 1013 s_b_erei.bmp

1014 s_b_erin.bmp 1049 s_b_bwse.bmp

1015 s_b_mbed.bmp 1050 s_b_bwsf.bmp

1016 s_b_pabs.bmp 1051 s_b_bwic.bmp

1017 s_b_sere.bmp 1052 s_b_bwio.bmp

1018 s_b_steu.bmp 1053 s_b_bwmo.bmp

1019 s_b_unbe.bmp 1054 s_b_bwsd.bmp

1020 s_b_unti.bmp 1055 s_b_bwfo.bmp

1021 s_b_were.bmp 1056 s_b_bwrs.bmp

1022 s_b_whil.bmp 1057 s_b_bwrp.bmp

1023 s_b_sump.bmp 1058 s_b_bwrv.bmp

1024 s_b_empl.bmp 1059 s_s_mdac.bmp

1025 s_b_timz.bmp 1060 s_s_mdin.bmp

1026 s_b_robj.bmp 1061 s_s_txac.bmp

1027 s_s_qual.bmp 1062 s_s_txin.bmp

1028 s_s_isoc.bmp 1063 s_s_hiac.bmp

1029 s_b_cexi.bmp 1257 s_s_hiin.bmp

1030 s_b_area.bmp 1258 s_s_moac.bmp

1031 s_b_intf.bmp 1259 s_s_moin.bmp

1032 s_b_evnt.bmp 1260 s_b_stin.bmp

1033 s_b_refe.bmp 1261 s_b_stov.bmp

1034 s_b_task.bmp 1262 s_b_stou.bmp

1035 s_b_todo.bmp 1263 s_b_stco.bmp

1036 s_b_aexp.bmp 1264 s_b_para.bmp

1037 s_b_acom.bmp 1265 s_b_pari.bmp

1038 s_f_sapm.bmp 1266 s_b_pare.bmp

1039 s_f_comm.bmp 1267 s_b_parc.bmp

1040 s_f_usrm.bmp 1268 s_b_parr.bmp

1041 s_f_favo.bmp 1269 s_b_clas.bmp

1042 s_b_bwis.bmp 1270 s_b_intc.bmp

1043 s_b_bwap.bmp 1271 s_b_attr.bmp

1044 s_b_bwia.bmp 1272 s_b_klat.bmp

1045 s_b_bwiu.bmp 1273 s_b_inat.bmp

1046 s_b_bwru.bmp 1274 s_b_meth.bmp

1047 s_b_bwsg.bmp 1275 s_b_klme.bmp

SAP 
character

Icon bitmap SAP 
character

Icon bitmap
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1048 s_b_bwsr.bmp 1276 s_b_inme.bmp

1277 s_b_even.bmp 1312 s_b_dmrk.bmp

1278 s_b_kons.bmp 1313 s_b_invs.bmp

1279 s_b_uede.bmp 1314 s_b_invz.bmp

1280 s_b_conn.bmp 1315 s_b_fort.bmp

1281 s_b_verb.bmp 1316 s_n_crit.bmp

1282 s_b_inik.bmp 1317 s_n_erro.bmp

1283 s_s_wstr.bmp 1318 s_n_info.bmp

1284 s_s_wsra.bmp 1319 s_n_ques.bmp

1285 s_s_wssh.bmp 1320 s_n_warn.bmp

1286 s_s_wspl.bmp 1321 s_b_urls.bmp

1287 s_s_wspo.bmp 1322 s_f_mosh.bmp

1288 s_s_wstf.bmp 1323 s_b_pein.bmp

1289 s_s_wsdo.bmp 1324 s_b_paus.bmp

1290 s_b_selc.bmp 1325 s_b_sumi.bmp

1291 s_b_strc.bmp 1326 s_b_okye.bmp

1292 s_b_fenc.bmp 1327 s_b_okno.bmp

1293 s_b_bwra.bmp 1328 s_b_rksi.bmp

1294 s_s_chaa.bmp 1329 s_b_rkqi.bmp

1295 s_s_chai.bmp 1330 s_b_rkzz.bmp

1296 s_s_keya.bmp 1331 s_b_rkkm.bmp

1297 s_s_keyi.bmp 1332 s_b_rkmo.bmp

1298 s_b_bwiw.bmp 1333 s_b_rkab.bmp

1299 s_b_bwwi.bmp 1334 s_b_rkmz.bmp

1300 s_b_erte.bmp 1335 s_b_rkhi.bmp

1301 s_s_grck.bmp 1336 s_b_mmak.bmp

1302 s_b_aboa.bmp 1337 s_b_movr.bmp

1303 s_b_abob.bmp 1338 s_b_msho.bmp

1304 s_b_abpl.bmp 1339 s_b_mbac.bmp

1305 s_b_absc.bmp 1340 s_b_noac.bmp

1306 s_b_abmb.bmp 1341 s_b_offe.bmp

1307 s_b_abma.bmp 1342 s_b_ofde.bmp

1308 s_b_abca.bmp 1343 s_b_ofev.bmp

1309 s_b_abcb.bmp 1344 s_b_ofoo.bmp

1310 s_b_bomb.bmp 1345 s_b_ofwc.bmp
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1311 s_b_dact.bmp 1346 s_b_ofpd.bmp

1347 s_b_ofcb.bmp 1382 s_b_warg.bmp

1348 s_b_ofte.bmp 1383 s_b_hint.bmp

1349 s_b_wsab.bmp 1384 s_b_plaa.bmp

1350 s_b_odsa.bmp 1385 s_b_plaw.bmp

1351 s_b_odsi.bmp 1386 s_b_repo.bmp

1352 s_b_inpa.bmp 1387 s_b_wopa.bmp

1353 s_b_acfa.bmp 1388 s_b_equi.bmp

1354 s_b_acsu.bmp 1389 s_b_tepl.bmp

1355 s_b_dims.bmp 1390 s_b_slis.bmp

1356 s_b_tina.bmp 1391 s_b_slip.bmp

1357 s_b_arle.bmp 1392 s_b_docu.bmp

1358 s_b_arri.bmp 1393 s_b_docr.bmp

1359 s_b_abap.bmp 1394 s_b_matr.bmp

1360 s_b_abal.bmp 1395 s_b_chno.bmp

1361 s_b_trst.bmp 1396 s_b_tfly.bmp

1362 s_b_oper.bmp 1397 s_b_tcar.bmp

1363 s_b_acty.bmp 1398 s_b_hotl.bmp

1364 s_b_orda.bmp 1399 s_b_trai.bmp

1365 s_b_cust.bmp 1400 s_b_mony.bmp

1366 s_b_cewa.bmp 1401 s_b_ques.bmp

1367 s_b_dilo.bmp 1402 s_b_boye.bmp

1368 s_b_dice.bmp 1403 s_b_bono.bmp

1369 s_b_cuwa.bmp 1404 s_b_open.bmp

1370 s_b_trap.bmp 1405 s_b_bokd.bmp

1371 s_b_matl.bmp 1406 s_b_pbkd.bmp

1372 s_b_modl.bmp 1407 s_b_ston.bmp

1373 s_b_plnt.bmp 1408 s_b_pref.bmp

1374 s_b_prog.bmp 1409 s_b_sten.bmp

1375 s_b_resh.bmp 1410 s_b_step.bmp

1376 s_b_resu.bmp 1411 s_b_reve.bmp

1377 s_b_stol.bmp 1412 s_b_exch.bmp

1378 s_b_supp.bmp 1413 s_b_cass.bmp

1379 s_b_tram.bmp 1414 s_b_wloa.bmp

1380 s_b_loca.bmp 1415 s_b_prop.bmp
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1381 s_b_alet.bmp 1416 s_b_anwe.bmp

1417 s_b_abwe.bmp 1452 s_b_pruc.bmp

1418 s_b_ticl.bmp 1453 s_b_pvor.bmp

1419 s_b_post.bmp 1454 s_b_pvou.bmp

1420 s_b_part.bmp 1455 s_b_pfik.bmp

1421 s_b_tsak.bmp 1456 s_b_pnar.bmp

1422 s_b_cost.bmp 1457 s_b_pfka.bmp

1423 s_b_mngr.bmp 1458 s_b_pvef.bmp

1424 s_b_ogun.bmp 1459 s_b_pver.bmp

1425 s_b_quer.bmp 1460 s_b_pvre.bmp

1426 s_b_ibox.bmp 1461 s_dagoch.bmp

1427 s_b_fast.bmp 1462 s_wfdoku.bmp

1428 s_b_life.bmp 1463 s_wflink.bmp

1429 s_b_work.bmp 1464 s_wfulnk.bmp

1430 s_b_grad.bmp 1465 s_wfwire.bmp

1431 s_b_xtra.bmp 1466 s_wfwirs.bmp

1432 s_b_cnvt.bmp 1467 s_wfwist.bmp

1433 s_b_rela.bmp 1468 s_wfwico.bmp

1434 s_b_conf.bmp 1469 s_wfwiwa.bmp

1435 s_b_wiza.bmp 1470 s_wfwicp.bmp

1436 s_s_ledi.bmp 1471 s_wfwier.bmp

1437 s_b_stor.bmp 1472 s_wfwica.bmp

1438 s_b_link.bmp 1473 s_wfrewi.bmp

1439 s_b_alla.bmp 1474 s_wfrpwi.bmp

1440 s_b_alll.bmp 1475 s_procen.bmp

1441 s_b_alea.bmp 1476 s_wfrusy.bmp

1442 s_b_alel.bmp 1477 s_wfpara.bmp

1443 s_b_clev.bmp 1478 s_xjapan.bmp

1444 s_b_inev.bmp 1479 s_sapals.bmp

1445 s_b_alia.bmp 1480 s_douane.bmp

1446 s_b_objc.bmp 1481 s_leglrg.bmp

1447 s_b_jobs.bmp 1482 s_comcod.bmp

1448 s_b_elie.bmp 1483 s_einska.bmp

1449 s_b_klie.bmp 1484 s_bautel.bmp

1450 s_b_vlie.bmp 1485 s_leiart.bmp
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1451 s_b_pruu.bmp 1486 s_mietvt.bmp

1487 s_immoob.bmp 1525 s_psacel.bmp

1488 s_comple.bmp 1526 s_psrela.bmp

1489 s_partne.bmp 1528 s_xbatch.bmp

1490 s_protok.bmp 1529 s_addata.bmp

1491 s_objlis.bmp 1530 s_xstock.bmp

1492 s_lisvie.bmp 1531 s_accass.bmp

1493 s_textva.bmp 1532 s_lotori.bmp

1494 s_abcana.bmp 1533 s_inslot.bmp

1495 s_varcho.bmp 1534 s_shexjo.bmp

1496 s_varsav.bmp 1535 s_sporeq.bmp

1497 s_korout.bmp 1536 s_outreq.bmp

1498 s_incdec.bmp 1537 s_delfav.bmp

1499 s_decdec.bmp 1538 s_shoeve.bmp

1500 s_fehler.bmp 1539 s_sposta.bmp

1501 s_kontak.bmp 1540 s_insfav.bmp

1502 s_xtelin.bmp 1541 s_printp.bmp

1503 s_xnafta.bmp 1542 s_userel.bmp

1504 s_x___eu.bmp 1543 s_maprel.bmp

1505 s_telout.bmp 1544 s_crecop.bmp

1506 s_conare.bmp 1600 s_xflush.bmp

1507 s_distli.bmp 1601 s_defect.bmp

1508 s_mailsu.bmp 1602 s_gistab.bmp

1509 s_mailsr.bmp 1603 s_bwincs.bmp

1510 s_envope.bmp 1604 s_bwinci.bmp

1511 s_envclo.bmp 1605 s_bwiocs.bmp

1512 s_offdoc.bmp 1606 s_bwsuva.bmp

1513 s_colgre.bmp 1607 s_dopopr.bmp

1517 s_packin.bmp 1608 s_cumada.bmp

1518 s_unpack.bmp 1609 s_statov.bmp

1519 s_emhaun.bmp 1610 s_dohede.bmp

1520 s_outlig.bmp 1611 s_doitde.bmp

1521 s_psprde.bmp 1612 s_avache.bmp

1522 s_pswbel.bmp 1613 s_xprice.bmp

1523 s_psnehe.bmp 1614 s_scline.bmp
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1524 s_psneac.bmp 1615 s_avasho.bmp

1616 s_statis.bmp 1653 s_datama.bmp

1617 s_xclaim.bmp 1654 s_colred.bmp

1618 s_lokpkt.bmp 1655 s_bwchsa.bmp

1619 s_auftrg.bmp 1656 s_bwkesa.bmp

1620 s_besuch.bmp 1657 s_bwious.bmp

1621 s_zusuch.bmp 1658 s_bwtisa.bmp

1622 s_attach.bmp 1659 s_bwrusa.bmp

1623 s_clofol.bmp 1660 s_bwresa.bmp

1624 s_opfold.bmp 1661 s_bwvasa.bmp

1625 s_objfol.bmp 1662 s_bwress.bmp

1626 s_outbox.bmp 1663 s_bwsesa.bmp

1627 s_resubm.bmp 1664 s_insmet.bmp

1628 s_prifil.bmp 1665 s_catalg.bmp

1629 s_pubfil.bmp 1666 s_inmali.bmp

1630 s_subscr.bmp 1667 s_inscha.bmp

1631 s_averag.bmp 1668 s_physam.bmp

1632 s_x_bold.bmp 1669 s_bwfosa.bmp

1633 s_italic.bmp 1670 s_bwincp.bmp

1634 s_underl.bmp 1671 s_bustel.bmp

1635 s_aligle.bmp 1672 s_financ.bmp

1636 s_aligri.bmp 1673 s_recrul.bmp

1637 s_aligce.bmp 1674 s_reclas.bmp

1638 s_justif.bmp 1675 s_remove.bmp

1639 s_xcolor.bmp 1676 s_earmar.bmp

1640 s_delatt.bmp 1677 s_deputy.bmp

1641 s_xidocs.bmp 1678 s_budupd.bmp

1642 s_x_host.bmp 1679 s_budtra.bmp

1643 s_symspo.bmp 1680 s_bwseac.bmp

1644 s_syrese.bmp 1681 s_bwsein.bmp

1645 s_sylose.bmp 1682 s_bwsesp.bmp

1646 s_syalse.bmp 1683 s_massch.bmp

1647 s_connec.bmp 1684 s_intcri.bmp

1648 s_discon.bmp 1685 s_intunc.bmp

1649 s_filtun.bmp 1686 s_chocol.bmp
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1651 s_intund.bmp 1687 s_tot_up.bmp

1688 s_tot_do.bmp 1723 s_conobj.bmp

1689 s_pageup.bmp 1724 s_objeli.bmp

1690 s_pagedo.bmp 1725 s_folder.bmp

1691 s_readfi.bmp 1726 s_differ.bmp

1692 s_writfi.bmp 1727 s_difbac.bmp

1693 s_editfi.bmp 1728 s_sysdem.bmp

1694 s_psmile.bmp 1729 s_takove.bmp

1695 s_psrptx.bmp 1730 s_termin.bmp

1696 s_elemen.bmp 1731 s_trirel.bmp

1697 s_struct.bmp 1732 s_projec.bmp

1698 s_lagerb.bmp 1733 s_sickne.bmp

1699 s_routin.bmp 1734 s_holida.bmp

1700 s_maroal.bmp 1735 s_x_role.bmp

1701 s_rosuop.bmp 1736 s_peradm.bmp

1702 s_roreso.bmp 1737 s_x__pdf.bmp

1703 s_rouseq.bmp 1738 s_x__bmp.bmp

1704 s_bosuit.bmp 1739 s_x__fax.bmp

1705 s_effper.bmp 1740 s_x__gif.bmp

1706 s_keydat.bmp 1741 s_x__hlp.bmp

1707 s_selper.bmp 1742 s_x__htt.bmp

1708 s_x__eff.bmp 1743 s_x__its.bmp

1709 s_supare.bmp 1744 s_x__jpg.bmp

1710 s_repcal.bmp 1745 s_x__msg.bmp

1711 s_assign.bmp 1746 s_x__xls.bmp

1712 s_unassi.bmp 1747 s_x__xlv.bmp

1713 s_systre.bmp 1748 s_x__htm.bmp

1714 s_systpl.bmp 1749 s_x__ppt.bmp

1715 s_transl.bmp 1750 s_x__dot.bmp

1716 s_trasho.bmp 1751 s_x__doc.bmp

1717 s_chapas.bmp 1752 s_x__eml.bmp

1718 s_distri.bmp 1753 s_x__rtf.bmp

1719 s_system.bmp 1754 s_x__tif.bmp

1720 s_actgro.bmp 1755 s_x__wri.bmp

1721 s_usegro.bmp 1756 s_x__lwp.bmp
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1722 s_dislin.bmp 1757 s_xlotus.bmp

1758 s_x__vsd.bmp 1797 s_liofad.bmp

1759 s_defwin.bmp 1798 s_appbal.bmp

1760 s_distre.bmp 1799 s_bpmada.bmp

1761 s_extsea.bmp 1800 s_inclog.bmp

1762 s_cloobj.bmp 1801 s_messag.bmp

1763 s_x_open.bmp 1802 s_telcal.bmp

1764 s_policy.bmp 1803 s_xvisit.bmp

1765 s_paymen.bmp 1804 s_letter.bmp

1766 s_catast.bmp 1805 s_operat.bmp

1767 s_aggreg.bmp 1806 s_sysadm.bmp

1768 s_supein.bmp 1807 s_x__sap.bmp

1769 s_suinpr.bmp 1808 s_pubobj.bmp

1770 s_subveh.bmp 1809 s_summar.bmp

1771 s_supepr.bmp 1810 s_sumund.bmp

1772 s_subbui.bmp 1811 s_sumneg.bmp

1773 s_suboit.bmp 1812 s_nospca.bmp

1774 s_suboin.bmp 1813 s_nospcb.bmp

1775 s_suensi.bmp 1814 s_nospcc.bmp

1776 s_sufiim.bmp 1815 s_nospcd.bmp

1781 s_daarex.bmp 1816 s_nospce.bmp

1782 s_daarso.bmp 1817 s_manage.bmp

1783 s_xscrap.bmp 1818 s_x__tbh.bmp

1784 s_imalre.bmp 1819 s_tbhhol.bmp

1785 s_imtrre.bmp 1820 s_newemp.bmp

1786 s_togdis.bmp 1821 s_incemp.bmp

1787 s_togfun.bmp 1822 s_outemp.bmp

1788 s_perset.bmp 1823 s_obspos.bmp

1789 s_projct.bmp 1824 s_terpos.bmp

1790 s_incobj.bmp 1825 s_shapos.bmp

1791 s_transf.bmp 1826 s_obshpo.bmp

1792 s_distco.bmp 1827 s_teshpo.bmp

1793 s_adjcon.bmp 1828 s_positi.bmp

1794 s_stacon.bmp 1829 s_crepos.bmp

1795 s_modobj.bmp 1830 s_orguni.bmp
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1796 s_sewico.bmp 1831 s_teorun.bmp

1832 s_neorun.bmp 1867 s_stabst.bmp

1833 s_ouorun.bmp 1868 s_sta_no.bmp

1834 s_inorun.bmp 1869 s_drwsel.bmp

1835 s_newtas.bmp 1870 s_drwfre.bmp

1836 s_tertas.bmp 1871 s_drwarr.bmp

1837 s_outtas.bmp 1872 s_drwlin.bmp

1838 s_inctas.bmp 1873 s_drwpll.bmp

1839 s_outjob.bmp 1874 s_drwell.bmp

1840 s_incjob.bmp 1875 s_drwplg.bmp

1841 s_newjob.bmp 1876 s_drwrec.bmp

1842 s_terjob.bmp 1877 s_drwang.bmp

1843 s_incoob.bmp 1878 s_drwlir.bmp

1844 s_outobj.bmp 1879 s_drwrad.bmp

1845 s_laanhi.bmp 1880 s_bwexmo.bmp

1846 s_laanvo.bmp 1881 s_bookma.bmp

1847 s_laquhi.bmp 1882 s_trstin.bmp

1848 s_laquvo.bmp 1883 s_bwexce.bmp

1849 s_x_hold.bmp 1884 s_rankin.bmp

1850 s_holund.bmp 1885 s_bhnode.bmp

1851 s_varian.bmp 1886 s_aenode.bmp

1852 s_flarat.bmp 1887 s_xanode.bmp

1853 s_bwssow.bmp 1888 s_cvnode.bmp

1854 s_wfjoin.bmp 1889 s_xsnode.bmp

1855 s_wfproc.bmp 1890 s_xenode.bmp

1856 s_xbgjob.bmp 1891 s_apnode.bmp

1857 s_jobdet.bmp 1892 s_xvnode.bmp

1858 s_systyp.bmp 1893 s_mdnode.bmp

1859 s_comact.bmp 1894 s_aanode.bmp

1860 s_tredwn.bmp 1895 s_axnode.bmp

1861 s_tredcr.bmp 1896 s_opnode.bmp

1862 s_treunc.bmp 1897 s_acnode.bmp

1863 s_treris.bmp 1898 s_vtnode.bmp

1864 s_tre_up.bmp 1899 s_vanode.bmp

1865 s_staale.bmp 1900 s_x_lseg.bmp
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1866 s_sta_ok.bmp 1901 s_xpline.bmp

1902 s_bpnode.bmp 1937 s_simfld.bmp

1903 s_gisbar.bmp 1938 s_trapro.bmp

1904 s_giscol.bmp 1939 s_helpon.bmp

1905 s_gisdem.bmp 1940 s_helpff.bmp

1906 s_gisdot.bmp 1941 s_dihelp.bmp

1907 s_gislay.bmp 1942 s_dihlac.bmp

1908 s_gispan.bmp 1943 s_stacri.bmp

1909 s_gispie.bmp 1944 s_f_sefi.bmp

1910 s_gispro.bmp 1945 s_f_seof.bmp

1911 s_gisspa.bmp 1946 s_f_seem.bmp

1912 s_gissym.bmp 1947 s_conalt.bmp

1913 s_clansw.bmp 1948 s_proalt.bmp

1914 s_clalte.bmp 1949 s_propro.bmp

1915 s_clhold.bmp 1950 s_wrkflo.bmp

1916 s_cldefl.bmp 1951 s_domosp.bmp

1917 s_clcons.bmp 1952 s_relcla.bmp

1918 s_clconf.bmp 1953 s_ioattr.bmp

1919 s_clbltr.bmp 1954 s_virecl.bmp

1920 s_clreco.bmp 1955 s_clcosp.bmp

1921 s_clretr.bmp 1956 s_ioprev.bmp

1922 s_clwatr.bmp 1957 s_concla.bmp

1923 s_crback.bmp 1958 s_loiocl.bmp

1924 s_prback.bmp 1959 s_viloio.bmp

1925 s_bwrasa.bmp 1960 s_phiocl.bmp

1926 s_bwrasi.bmp 1961 s_viphcl.bmp

1927 s_sncinf.bmp 1962 s_paragr.bmp

1928 s_delive.bmp 1963 s_conten.bmp

1929 s_ppeasp.bmp 1964 s_bsccon.bmp

1930 s_ppeash.bmp

1931 s_ppepaa.bmp

1932 s_bindoc.bmp

1933 s_anydoc.bmp

1934 s_otfdoc.bmp

1935 s_txtfld.bmp
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1936 s_fldtxt.bmp
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SAPGOF using PCL font metrics

In standard SAP installations, the SAPGOF device type uses the same font 
configuration as the POST2 device type (POSTSCPT in SAP releases prior to 
4.5A). This means that the character and line spacing in OTF data is based on 
PostScript font metrics, which in turn means the OTF data StreamServe processes 
is formatted in the same way as PostScript output from the SAP system. 
Therefore, if an organization designs the layout of their documents to print on 
Hewlett Packard LaserJet printers using PCL-5, output from StreamServe will be 
different from their standard SAP system output.

In order to ensure that StreamServe output is formatted in the same way as 
existing PCL-5 output, you need to modify the SAPGOF device type to use PCL 
font metrics instead of PostScript font metrics.

StreamServe device types

StreamServe provides device types that use PCL font metrics instead of 
PostScript font metrics for HP LaserJet printers.

These device types are available on the StreamServe Connect for SAP - Output+ 
CD, in the following directory:

\User Documentation\Devices\Unsupported

Note: StreamServe does not support these device types – they are merely 
intended as a guideline for customers who want to perform the required 
modifications themselves.
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A



80
SAPGOF using PCL font metrics
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A



81
Maintaining Messages created 
using the FormOUT tool

Using Design Center, you can upgrade and maintain Messages created using the 
PageIN and FormOUT tools.

Included activities

• Verifying files for maintaining Messages on page 82

• Maintaining Form Messages on page 82

• Maintaining Report Messages on page 83
StreamServe Persuasion SP5 StreamServe Connect for SAP - Output+ User Guide Rev A



82 Verifying files for maintaining Messages
Maintaining Messages created using the FormOUT tool
Verifying files for maintaining Messages
Before you maintain Messages created using the FormOUT tool, you must verify 
that folders and files required for using the FormOUT tool are available. 

See the Output+ part of the StreamServe Connect for SAP Installation Guide.

Maintaining Form Messages
Using Design Center, you can not create new Form Messages using the 
FormOUT tool. However, you can maintain Form Messages that were previously 
created in the FormOUT tool using earlier versions of StreamServe.

To create new Messages for Forms using Design Center, see Creating Messages 
for SAPGOF data on page 26.

Prerequisites

Before you can use Design Center to maintain Messages from an existing Project 
created in an earlier version of StreamServe, you must upgrade the Project to a 
Design Center Project. For more information, see the Upgrading documentation.

Note: When you upgrade Projects containing Form Messages, ensure you 
upgrade any included Resources.

To maintain Form Messages using Design Center

1 In Design Center, open the Project containing the Form Message.

Note: To open a Project in Design Center, the Project must have been 
upgraded to a 4.0 Design Center Project.

2 Open the FormOUT process for the Form.

3 Make the necessary modifications to the FormOUT Process. See Defining a 
Form in the FormOUT tool on page 94.

4 Save the FormOUT Process.
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Maintaining Report Messages
Using Design Center, you can maintain Report Messages that were previously 
created in the Project tool using earlier versions of StreamServe.

To create new Messages for Reports using Design Center, see Creating Messages 
for SAPGOF data on page 26.

Prerequisites

Before you can use Design Center to maintain Messages from an existing Project 
created in an earlier version of StreamServe, you must upgrade the Project to a 
Design Center Project. For more information, see the Upgrading documentation.

Note: When you upgrade Projects containing Report Messages, ensure you 
upgrade any included Resources.

To maintain Report Messages using Design Center

1 In Design Center, open the Project containing the Report Message.

Note: To open a Project in Design Center, the Project must have been 
upgraded to a 4.0 Design Center Project.

2 Open the PageIN Event for the Report.

3 Make the necessary modifications to the PageIN Event. See Configuring a 
PageIN Event for ABAP List data on page 113.

4 Save the PageIN Event.

5 Open the PageOUT Process for the Report.

6 Make the necessary modifications to the PageOUT Process. See 
Configuring a formatted ABAP List Process on page 114.

7 Save the PageOUT Process.
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Maintaining Platforms
Projects containing Messages created using the FormOUT tool do not require 
specific Platform settings. However, you do need to verify that the path to the 
default directory for the map files is correctly specified in the Platform.

Note: The bitmaps you will map must be imported as image resources in the 
resource set. In earlier versions they were stored in subfolders to a 
\Formfiles folder. For available bitmaps, see SAP characters and icons 
on page 61.

Verifying the default map file directory
The Output+ Connect solution includes a number of map files, which enable 
StreamServer to process SAPGOF data.

The map files are default.map, font.map, symbol.map and barcode.map.

You must verify that the path to the default directory for the map files is correctly 
specified in the Platform.

To verify the default map file directory

1 In Design Center, select Edit > Custom Settings. The Edit Custom fields 
dialog opens.

2 In the Access points tree, browse to the logical layer of the platform.

3 In the Custom field, verify that the correct path is specified to the directory 
of the SAPGOF map files. For example.

PathOTFMap "C:\SAP\Formfiles"

4 If necessary, specify the path to the new directory.

5 Click OK.
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Maintaining Runtime
For StreamServe 3.0.1 and earlier, the Output+ agent was configured for the input 
connector in the Platform. From StreamServe 4.0, the Output+ agent is 
configured on the Event in the Runtime.

When an earlier StreamServe Project is upgraded, the Output+ agent is 
automatically set for Form Messages. For Report Messages, you need to set the 
Output+ agent manually.

The Output+ agent is the only specific setting required in Runtime configurations 
for existing Messages created using the FormOUT tool.

To configure the Output+ agent for Report Messages

1 In the Runtime configuration, right-click the PageIN Event, and select 
Settings. The Runtime Event Settings dialog box opens.

2 In the Input type box, select StreamServe Connect for SAP - Output+.

3 Click OK.
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Useful SAP transaction codes

This section lists SAP transaction codes which are commonly used in the SAP 
system to activate transactions. 

Note: To enter a transaction code from any screen within the SAP system other 
than the initial screen, prefix the code with /n. For example, the /nVF03 
transaction code would display the Display Billing Document screen from 
any screen in the SAP system.

Configuration

Spool functions

Form processing

SPRO Customizing

OMFE Processing Program/Layout Set for Purchase Order (MM)

V/30 Processing Program/Layout Set for Order Confirmation (SD)

V/34 Processing Program/Layout Set for Delivery Note (SD)

V/40 Processing Program/Layout Set for Invoice (SD)

SPAD Spool Administration

SP01 Spool Requests

SE71 SAPscript

SE73 Font Maintenance

SE78 Graphics Management

SMARTFORMS Smart Forms

SO10 Standard Texts
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Programs and reports

Generating application output

Data and metadata

SE38 ABAP Editor

RSTXSCRP Import/Export SAPscript objects

RSTXSYMB List SAP symbols

RSTXICON List SAP icons

RSPO0049 Activate Access Method Z (Spool Exit)

ME90 Print Purchase Order (MM)

VA02 Change Sales Order (Order Confirmation, SD)

VA03 Display Sales Order (Order Confirmation, SD)

VF02 Change Billing Document (Invoice, SD)

VF03 Display Billing Document (Invoice, SD)

VL02 Change Outbound Delivery (Delivery Note, SD)

VL03 Display Outbound Delivery (Delivery Note, SD)

SM69 List of external commands (for box drawing characters)

SM04 List of users currently logged on (short list)

SE11 Data Dictionary

SE16 Data Browser

WE63 IDoc Types
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